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Motivation et objectifs du cours

Les interfaces graphiques ont permis la démocratisation

de l'usage des ordinateurs et 'avenement du “numeérique”

Elles sont utilisées par des milliards de personnes chaque jour

Le but du cours est d’'introduire les concepts de base
de l'interaction humain-machine et

de la conception des interfaces humain-machine
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Plan du cours

Introduction / Historique / Styles d’interaction
Interaction graphique

Modele conceptuel

Analyse des besoins et Idéation

Conception visuelle

Evaluation de l'interaction
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L 'interaction humain-machine

% Interaction
4P

\ phénomene

@A a controler

Capacités: action, Capacités: calcul,
perception, cognition stockage, entrée/sortie

Environnement: physique, social,
organisationnel, culturel, etc.
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En realité, c'est plus complexe...

ment

PN
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Mais restons simples...
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L'interface utilisateur

Elements matériels et logiciels
qui permettent de controler I'interaction

Materiel : écran, clavier, souris, écran tactile, Kinect,
casque de realité virtuelle ou augmentée, internet des objets, etc.

Logiciel : interface graphique, interface vocale, monde virtuel, ...
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Boucle d’interaction
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Une application interactive...

- a un état interne @

- représente une partie de cet éetat

co— B

- reagit aux actions de l'utilisateur

10
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Par comparaison, un systeme algorithmique...

- lit ses entrées E — @

- exécute l'algorithme
- affiche les resultats > .

- et s'arréte !

11
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Modele conceptuel d’'une application interactive

—.-
< Feedback

S Commandes

Opérations puemmg Objets

12



Licence Informatique Paris-Saclay - (c) Michel Beaudouin-Lafon 2019-2022

Exemple : poster un message sur un chat

wil Orange F = 12:40 < 95 % .
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Deux proprietes d’'une application interactive

Utile :
Doit répondre aux besoins des utilisateurs
=> Collecter, analyser et comprendre ces besoins

Utilisable :
Doit étre adaptée aux capacites des utilisateurs
=> Connaitre ces capacités et leur contexte d’'usage
=> Utiliser des méthodes et regles de conception adaptées

“User eXperience” ou UX = expérience utilisateur

14
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ATTENTION !

Nous utilisons tous des interfaces
Nous avons tous des idees pour les améeliorer
... mais cela ne fait pas de nous des concepteurs d’interfaces

= L'IHM est un domaine pluridisciplinaire

15
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Domaine pluridisciplinaire
sciences humaines

physiologie ~ anthropologie
sociologie

psychologie design industriel

design graphique

Interactive

systems design

typographie
informatique

] _ architecture
électronique

mécanique  optique

sciences & ingénierie

16
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ATTENTION !

Nous utilisons tous des interfaces
Nous avons tous des idees pour les améeliorer
... mais cela ne fait pas de nous des concepteurs d’interfaces

= L'IHM est un domaine pluridisciplinaire

Paradoxe de I'lHM:
Mesure de succes = invisibilité / transparence de l'interface
MAIS faire simple, c’est compliqué !

17
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Conception de systemes interactifs

Approche itéerative : conception centrée sur l'utilisateur

Evaluation Conception

Développement j

18
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Styles d’interaction
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Styles d’interaction

Style d’interaction = ensemble de principes et
de moyens d’'interaction d’'une famille d’interfaces

Langage de commande
Menus & Formulaires
Navigation hypertexte
Manipulation directe

Interaction gestuelle
Interaction en langage naturel
Reéalite virtuelle et augmentée

20
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Langage de commande

Exemple : “shell” Unix/Linux dans 'application Terminal

Le systeme affiche une invite (% par exemple)

et attend une commande de l'utilisateur ¢ date

Une fois la commande entrée, le systeme |'exécute, Fri Feb 11
affiche son résultat, et a nouveau l'invite

Une commande est formée
d’'un nom de commande [sjas)e recherche de chaine
d'options -1 ignorer maj/min
et de parametres RN el /11D/” dans noms.ixt

21
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Langage de commande

Avantages
Rapide pour les experts
Flexible : “pipe” Unix pour enchainer les commandes
grep -i mbl noms.txt | sort | uniq

Puissant : création de scripts
Créer ses propres commandes

Inconvénients
Il faut connaitre les commandes et leur syntaxe
Apprentissage difficile
Risques d’erreurs

22



Menus et formulaires
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Menu : le systeme affiche les choix possibles

| 'utilisateur choisit dans la liste

4 |Microsoft QuickBASIC

that do you want to do
FFFFIFOOOOOOOOOOO0E

. Add a record

. Delete a record

. Modifiy record

. lS;.ea_rch database
»

- int a report

. Display all records

. Quit the program

mber of

Please press the nu

(? will exit the program)

\that is your Selection?

n_

File | Edit Window Help
() New Cerl4+N
& Open Ctrl+0

Close
n Save  Chrl+5S

Save As...

Exit

Formulaire : le systeme affiche les champs a compléter
L 'utilisateur les complete dans I'ordre qui lui convient

Narne|

Addre::Stl
|

City: |

State | 'I ap. |

Create account
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Menus et formulaires o—

Avantages
Guide l'utilisateur
Reéduit 'apprentissage et les erreurs
Facilite I'entrée des données
Facilite 'exploration des possibilités de l'interface

Inconveénients
Prend de la place a I'’ecran
Peut poser probleme sur de petits écrans
L'entrée des données peut étre fastidieuse
Importance de “bonnes” valeurs par défaut

24
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click hef

Navigation hypertexte / hypermedia

L'information est organisée selon un graphe :
Les nceuds contiennent les éléments d’information
Les ancres représentent des points d'intérét dans les nceuds
Les liens relient des ancres ou des nceuds entre eux

L'utilisateur navigue d’'un nceud a l'autre
en suivant les liens

Le Web est (au départ) un systeme hypertexte

25
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Aick eT :

Navigation hypertexte / hypermedia

Avantages
Acces progressif a une grande quantité d’information
Possibilité d’organiser I'information
par niveaux de deétail
par theme

Inconveénients
Difficulté a savoir ce que I'on n'a pas vu
Risque de se “perdre”
Difficulté a retrouver une information
d'ou lI'apparition des moteurs de recherche

26
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Exemple

: Ssite de e-commerce

Menu

Navigation

amazon

© n

Amazon.fr  Ventes Flash -

= Toutes ‘ AmazonBasics Chez MR

Outlet

o

Formulaire =

Amazon Prime
(] vprime

Promotions
[] ventes Flash

Affiner la catégorie
Livres
Santé, Forme et Diététique
Personnages scientifiques
Romans et littérature
Informatique & Internet
Livres anglais et étrangers
Coiffure et soins des cheveux
Boutique Kindle
Ebooks Kindle
~ Voir les 22 catégories

Moyenne des commentaires
client

Y o W W 17 & plus
W W W Y Y7 &plus
P W YT &plus
L7 YT T Iy & plus

Prix

0a5EUR
5a10EUR

10 4 20 EUR
20 a 50 EUR
Plus de 50 EUR

1-48 sur sur 1 000 résultats pour "intera

V Toutes nos catégories
Alexa Skills

Amazon Warehouse
Animalerie

Appareils Amazon
Applis & Jeux

Auto et Moto

Bagages

Beauté et Parfum
Beauté Premium

Bijoux

Boutique chéques-cadeaux
Boutique Kindle
Bricolage

Bébés & Puériculture
Chaussures et Sacs
Cuisine & Maison

DVD & Blu-ray

Epicerie

Fournitures de bureau
Gros électroménager
Handmade

High-Tech

Hygiéne et Santé
Informatique
Instruments de musique & Sono
Jardin

Jeux et Jouets

Jeux vidéo

Livres anglais et étrangers
Livres audio Audible
Livres en frangais
Logiciels

Luminaires et Eclairage
Mode

Moins de 10€

Montres

Musique : CD & Vinyles
Musique classique
Prime Video

Secteur industriel et scientifique

Sports et Loisirs
Téléchargement de musique

Vétements et accessoires
|

Toutes nos catégories * flinteraction homme machine Q

ntes Flash | 2

reconditionnées = Mos idées cadeaux ~

Fi

Formulaire

EN3

Interaction

Interaction homme-machine
de RIAHI CHEBBI-M

Broché

59,00¢

vprime Livraison GRATUITE d'ici
mercredi 4 novembre

— Navigation
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Menus + Formulaires + Navigation

Exemple de “Pattern” d'interface pour des applications de
- E-commerce
- Consommation de medias (musique, films, ...)

- News Recherche

Recherche : menus &
formulaire

Filtres : formulaire
Reésultats : navigation

Filtres Résultats

28
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Manipulation directe @

Base des interfaces graphiques actuelles

Représentation permanente des objets manipulés
Texte, documents, icOnes des fichiers, etc.

Actions physiques pour manipuler les objets
Sélection de texte, déplacement d’un fichier, etc.

Actions rapides et réversibles dont I'effet est immeédiatement visible
Drag-and-drop (cliquer-tirer)

29
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Seo

Manipulation directe : edition de documents

WYSIWIG : What You See Is What You Get

g s for Office Automation
Lavpe, High-Rezalation, Sit-Map

Oviol, Wlire Aut o ANy VIes IF s3cme Aee
Oviplays tar Office Automation Texe 90 graphics

Large, Hph-Peipdytign, BT M
0’.M1?vula e o ﬁlﬂlyl\f’epv\t\'edpcwr

1 avee Seve

Xerox Star 8010 (1981)




Manipulation directe : edition de documents

s - O Docwment? - Mcrosoht Werd prees=]
¢ . . @ ST R 1\ - nf
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Porte B 7 U dex x - A-FEaANR 3 e 2 ' ' > " 7] e Tae Nange a
J hytet ele
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-
|

On the Insert tab, the galleries indude items that are designed to coordinate with the overall look of
your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and
other document buliding blocks. When you create pictures, charts, or diagrams, they also coordinate
with your current document look.
[ You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab, You can also format text directly by
- using the other controls on the Home tab. Most controls offer a choice of using the look from the
| current theme or using a format that you specify directly.
|
.
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Interfaces graphiques actuelles : WIMP

Menus + Formulaires + Navigation + Manipulation Directe

Affichage
Windows (fenétres)
Icones et autres représentations graphiques

Interaction
Menus, formulaires, manipulation directe

Entrées
Pointage, sélection, gestes

S'applique également aux interfaces sur écran tactile
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Reconnaissance vs. Rappel

Interface fondée sur la reconnaissance :
Fournit de I'information sur les commandes accessibles,
afin que l'utilisateur puisse les reconnaitre
Exemples : menus, icones, barres d’outils, ...
=> plus simple d’acces, mais parfois moins efficace

Interface fondée sur le rappel (la mémoire) :

Nécessite que l'utilisateur ait appris les commande
et se les rappelle

Exemples : interface gestuelle, interface conversationnelle
(langage de commande, parole, langue naturelle)

=> plus difficile d’accés mais souvent plus efficace
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Autres styles d’interaction

Interaction gestuelle
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Interaction vocale

Réalité augmentée / mixte

34
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Autres styles d’interaction

Agents conversationnels Robots d'assistance

- i (aw -"J!
|

A dose friend wos involved in an ¥
accident ond passed away instontly. He i

Interaction tangible Interfaces cerveau-ordinateur

’ AR
g W NS SR

g AN

a
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Quelques styles d’interaction “futuristes”

InForm (2013, MIT) Zooids (2017, Inria)

36
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Holodesk (Microsoft, 2012)

ol
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RoomAlive (Microsoft, 2014)




InForm (MIT, 2013)
LINKED PHYSICAL OBJECTS




~
-
\
-
N\

Licence Informatique Paris-Saclay - (c) Michel Beaudouin-Lafon 2019-2022

Zooids (Inria, 2017)

- -~ - T~
5 —
OO

~Zooids:
Building Blocks for Swarm User Interfaces

Mathieu Le Goc"?4, Lawrence H. Kim?, Ali Parsaei?, Jean-Daniel Fekete'%, Pierre Dragicevic'*, Sean Follmer?

" Inria, ? Stanford University, > Universté Paris-Sud, 4 Université Paris-Saclay
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